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1. Introduction 

 

1.1. Professional training 
This course will explain the non linear and stability calculations in Scia Engineer. Most of the modules 
necessary for this calculation are included in the Professional edition .  
For some options a concept edition is sufficient or for other options an expert edition or an extra 
module is required. This will always be indicated in the corresponding paragraph. 
 

1.2. Introduction to non linear and stability 
In general, when modelling structures, a linear approach is followed. It can however be that certain 
parts of the structure do not behave linearly. Examples include supports or members which only act in 
compression or tension. This is where non-linear analysis is required. 
 
Another example is when performing structural analysis following the latest codes (i.e. Eurocode 3). 
When performing manual calculations, in most cases a linear 1st Order analysis is carried out. 
However, the assumptions of such analysis are not always valid and the codes then advise the use of 
2nd Order analysis, imperfections, etc.  
 
Scia Engineer contains specialized modules covering non-linear and stability related issues. In this 
course, the different aspects of these modules are regarded in detail. 
 
In the first part of the course, the non-linear modules are looked upon. First the 2nd Order calculation 
methods are explained and integrated with Eurocode 3. Next the local nonlinearities are examined 
including tension-only members, pressure-only supports, cable analysis, friction supports, etc.  
 
The non-linear part of the course is finished with an insight on how to apply imperfections according to 
Eurocode 3 using Scia Engineer. 
 
The second part of the course examines Stability calculations: the determination of the elastic critical 
buckling load of a structure. This analysis can be used to calculate the buckling length of a part of the 
structure or to determine if a 1st Order analysis may be carried out. 
 
The final chapter provides some common failure messages which occur during a non-linear analysis. 
This chapter points out the most likely causes of singularities and convergence failures. 
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2. Non-Linear behaviour of Structures 

2.1. Type of Non Linearity 
 
The non-linear behaviour of structures can be categorised in three different groups: 

- Geometrical non-linearity : The displacements are dependent on the strains in a non-linear 
way. 

- Physical non-linearity : The stresses are dependent on the strains in a non-linear way. 

- Local non-linearity : The geometry or the boundary conditions of the structure change during 
the solving of the equations. 

 
These three types of non linearities will be examined in detail in the following chapters. 
For a complete overview and theoretical background, reference is made to [1], [2], [3], [4], [5] and [6]. 
 
To be able to use non linearities in Scia Engineer this functionality should be enables in the Project 
data dialogue: 
 

 
 
And in the right column the necessary nonlinearity should be activated. 
 
 

2.2. Non Linear Combinations 
 
During a linear analysis, the principle of superposition is valid: the load cases are calculated and the 
combinations are composed after the calculation. 
 
For a non-linear analysis, this principle is not valid anymore. The combinations have to be assembled 
before starting the calculation. In Scia Engineer, this is done by defining Nonlinear Combinations . 
 

 
 
A non-linear combination is defined as a list of load cases where each load case has a specified 
coefficient. 
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In addition, for each non-linear combination it is possible to specify an initial Bow Imperfection and/or a 
Global Imperfection. Imperfections are regarded in Chapter 6. 
 

Note 

- The combinations defined as linear combinations can be imported as non-linear combinations. It is however 
important to keep in mind that during a non-linear calculation no combinations are generated. This implies for 
example that code specific combinations must first be exploded to linear combinations. These linear 
combinations can then be imported as non-linear combinations. 

This method makes sure that the code coefficients and relations between the load cases are correctly taken into 
account for the non-linear calculation.  
 
- To view the extreme results for the non-linear calculation, the non-linear combinations can be grouped 
within a result class. 
 
- The amount of non-linear combinations is limited to 1099. 
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3. Geometrical Non-Linearity – also possible with C oncept edition 

 
The options described here for the geometrical non linearities are also possible with a Concept 
edition . So the Professional edition is not required for this chapter, except for the stability calculation 
(and the calculation of αcr as explained shortly in this chapter). 
 
 
The non-linear behaviour is caused by the magnitude of the deformations.  
 
Take for example a simple beam: during a linear analysis, the relative deformation of the end nodes, in 
the direction of the beam axis is dependent on the strain of the beam. 
 
Due to a curvature of the beam, the distance between the end nodes is changed also. This implicates 
that the total strain is now not solely dependent on the displacement. 
 
This relation can now be looked upon for different cases: 

a) Small displacements, small rotations and small strains; 

b) Large displacements, Large rotations and small strains; 

c) Large displacements, Large rotations and Large strains; 
 
In Scia Engineer, methods a) and b) have been implemented for the analysis of geometrical non-linear 
structures. Method c) is less common in structural applications (for example rubber). 
 
Method a) is called the Timoshenko  method; method b) is called the Newton-Raphson  method. 
 
To activate the Geometrical Non-Linearity, the functionality Nonlinearity > 2 nd  Order – Geometrical 
nonlinearity  must be activated. 
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3.1. Overview 
Global analysis aims at determining the distribution of the internal forces and moments and the 
corresponding displacements in a structure subjected to a specified loading. 
The first important distinction that can be made between the methods of analysis is the one that 
separates elastic and plastic methods. Plastic analysis is subjected to some restrictions.  
Another important distinction is between the methods, which make allowance for, and those, which 
neglect the effects of the actual, displaced configuration of the structure. They are referred to 
respectively as second-order theory  and first-order theory  based methods.  
 
The second-order theory can be adopted in all cases, while first-order theory may be used only when 
the displacement effects on the structural behavior are negligible. 
 
The second-order effects are made up of a local or member second-order effects, referred to as the P-
δ effect, and a global second-order effect, referred to as the P-∆ effect. 
 

 
 
 
On the next page an overview of the global analysis following the EN 1993-1-1, chapter 5, will be 
given: 

o All the rules in this overview are given in the EN 1993-1-1 art. 5. For each step the rule will  
be indicated. The first rule (αcr > 10) will be explained in EN 1993-1-1 art. 5.2.1(3) . 

o In this overview 3 paths are defined: 

� Path 1: In this path a first order calculation will be executed 

� Path 2: In this path a second order calculation will be executed with global (and 
bow) imperfections. 

� Path 3: In this path a second order calculation will be executed with the buckling 
shape of the construction as imperfection. 

o The calculation will become more precise when choosing for a higher path. 

o The lower paths will result in a faster calculation, because a first order calculation can be 
executed without iterations, but this first-order theory may be used only when the 
displacement effects on the structural behavior are negligible. 

o In the next paragraphs the rules in this overview will be explained. 

To take into account all non-linearities in the model, non-linear load combinations are made. 
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5.2.2(3)c 

5.2.2(3)b 

5.2.2(5) 

5.2.2(7)b 

5.3.2(11) 

5.2.2(7)a 

5.2.2(3)a 

5.3.2(6) 

5.2.1(3) 

No Yes 

No Yes 

e0 if 
required 

e0 in all 
members 

Yes No 

αcr ≥ 10 

 
NEd > 25% Ncr 

(member) 

Members 
with e0 

αcr ≥ 3 

Increase sway 
effects with: 

crα
1

1

1

−
 

ηcr 

1b 2b 2c 3 

Global Imperfection φ 

2a 1a 

1st Order Analysis 2nd Order Analysis 

lb taken equal to L 

Structural Frame Stability 

Section Check 

Stability Check in plane 

Stability Check out of plane + LTB Check 

lb based on a global 
buckling mode 

  With:  ηcr Elastic critical buckling mode. 
  L Member system length 

  lb Buckling Length 
 

Path 1a specifies the so called Equivalent Column Method. In step 1b and 2a “l_b may be taken 
equal to L”. This is according to EC-EN so the user does not have to calculate the buckling factor =1. 
In further analysis a buckling factor smaller than 1 may be justified. 
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3.2. Alpha critical  
The calculation of alpha critical is done by a stability calculation in Scia Engineer. For this calculation a 
Professional or an Expert edition is necessary, so with the concept edition is this not possible. The 
stability calculation has been inputted in module esas.13. 
 
According to the EN 1993-1-1, 1st Order analysis may be used for a structure, if the increase of the 
relevant internal forces or moments or any other change of structural behaviour caused by 
deformations can be neglected. This condition may be assumed to be fulfilled, if the following criterion 
is satisfied: 

 ��� = �����	 ≥ 10 for elastic analysis 

 
With:  αcr: the factor by which the design loading has to be increased  

        to cause elastic instability in a global mode. 
    FEd:  the design loading on the structure. 

Fcr: the elastic critical buckling load for global instability,      
          based on initial elastic stiffnesses. 

 
If αcr has a value lower then 10, a 2nd Order calculation needs to be executed. Depending on the type 
of analysis, both Global and Local imperfections need to be considered. 
 
EN1993-1-1 prescribes that 2nd Order effects and imperfections may be accounted for both by the 
global analysis or partially by the global analysis and partially through individual stability checks of 
members. 
 
The calculation of Alpha critical and also Path 3 from the diagram of the previous paragraph will be 
explained in the chapter “Stability”. 
 
 

Example: Imperfections2D.esa 
 
The diagram is now illustrated on a steel frame including a global imperfection. This benchmark project 
is examined in detail in references [20] and [23]. 
 
A stability calculation for the frame gives a critical load factor αcr of 13,17 > 10 
 
This indicates that 2nd Order effects are negligible and a 1st Order analysis may be used for the 
structure. 
 
Path 1a  can thus be followed and a 1st Order  Calculation is executed. 
 
A Steel Code Check gives the following results: 
 

 
 
 
When Path 2a  is followed, using a Global imperfection and a 2nd  Order  Calculation according to 
Timoshenko , the Steel Code Check shows the following: 
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It can be seen that the results are practically the same which is as expected since the αcr is larger then 
10.  
 
The input of imperfections and execution of a Stability Calculation will be regarded in detail further in 
this course. 

 
 

 

3.3. Imperfections 
 
 
When performing a non-linear calculation, it is possible to input initial geometrical imperfections: initial 
deformations and curvatures. These imperfections take into account the fact that the structure is for 
example a bit inclined instead of perfectly vertical or that the members are not completely straight. 
 
To input geometrical imperfections, the functionality Nonlinearity > Initial deformations and 
curvature  must be activated. 
 

 
 
For each non-linear combination, the imperfections can then be set. 
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Difference is made between Global imperfections  (Initial deformations) and Bow Imperfections  
(Curvatures). 

 

3.3.1. Global frame imperfection ϕϕϕϕ 

The nodal coordinates define the geometry of the structure. Using initial deformations as global 
imperfections, additional displacements (in X and Y direction) can be inputted. These displacements 
will thus alter the geometry. 
 
The structure itself can therefore be modelled as straight; the inclination is given by the global 
imperfection. 
 
The global imperfection can be set in the following ways: 

- Simple Inclination 

- Deformation from Load case 

- Inclination Functions 

- Buckling Shape 
 
 

Simple Inclination 

The imperfection is defined as a simple inclination. The inclination is defined in mm per m height of the 
structure. More specifically a horizontal displacement is given in the global X and/or Y direction which 
has a linear relation to the height (global Z direction). 

 

Deformation from Load case 

The imperfection is defined by the displacements of a specified load case. This option can be used to 
take into account for example the imperfections due to the self-weight. Especially for slender beams 
this can be important. 

 

Inclination Functions 

The imperfection is defined by a deformation-to-height curve, similar to the Simple Inclination. The 
curve can then be assigned to an appropriate non-linear combination.  
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These inclination functions are entered through “Main -> Library -> Structure, Analysis -> Initial 
deformations”: 

 

 

 
When the type is set to Manually , the function can be inputted by specifying the height and the 
horizontal displacement. 
 

 
 
The type Factor  allows a factor to be inputted at each height. In the definition of a non-linear 
combination, a manually inputted function can then be multiplied by this factor function. 
 
When choosing According to code , the inclination function is calculated according to the code. As 
shown during the 2nd Order calculations, Eurocode 3 ref.[27] defines the global imperfection the 
following way: 
 
 
 



Advanced Training 
 

11 

 

 = 1200 ∙ �� ∙ �� 

�� = �√�    but  
�� ≤ �� ≤ 1,0 

�� = �0,5 �1 + 1�� 

  

With: h The height of the structure in meters 

m The number of columns in a row including only those columns which carry a vertical  

load NEd not less than 50% of the average value of the vertical load per column in  
the plane considered. 

   

 
 
These parameters can be inputted after which the imperfection is automatically calculated: 
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An inclination function is defined independent of an axis. This means that the same function can be 
used to define the displacement in X in function of Z, or Y in function of Z, or X in function of Y,… 
 
In the definition of a non-linear combination, it can be specified between which axes the function 
defines a relation. 

 

 
The Sense  option allows the imperfection to be applied in the positive or negative direction (according 
to the chosen global direction). This way, a non-linear combination can for example be copied, where 
the original has a positive sense and the copy a negative sense to take into account both possibilities. 
 
Instead of the Sense , the Factor  function can be applied as specified above. The values of the factor 
function will be multiplied with the values of the defined inclination function. 
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Buckling Shape 

As an alternative to Global and Local imperfections, paragraph 5.3.2(11) of Eurocode 3 Ref.[27] allows 
the use of a buckling shape as a unique imperfection. For this option the Professional or Expert edition 
is necessary. This option has been inputted in module esas.13. 
 
To input geometrical imperfections, the functionality Nonlinearity > Initial deformations and 
curvature  and Stability must be activated. 
 

 
 
The calculation of the buckling shape through a stability calculation will be looked upon in Chapter 6. 
 
Since the buckling shape is dimensionless, Eurocode gives the formula to calculate the amplitude ηinit 
of the imperfection. In Ref.[29] examples are given to illustrate this method. In this reference, the 
amplitude is given as follows: 
 

cr
cry

cr
init IE

N
e η

η
η ⋅

⋅⋅
⋅=

''
max,

0  

 

( )
( )

( )2
1

2

0
1

1
2,0

λχ
γ

λχ

λα
⋅−

⋅−
⋅⋅−⋅= M

Rk

Rk

N

M
e   for  2,0>λ  

 

With: 
cr

Rk
N

N=λ  

 
  α =  The imperfection factor for the relevant buckling curve. 

χ =  The reduction factor for the relevant buckling curve, depending on the 
relevant cross-section. 

NRk =  The characteristic resistance to normal force of the critical cross-section, i.e. 
Npl,Rk. 

Ncr =  Elastic critical buckling load. 
MRk =  The characteristic moment resistance of the critical cross-section, i.e. Mel,Rk 

or Mel,Rk as relevant. 
ηcr =  Shape of the elastic critical buckling mode. 

=''
max,crη Maximal second derivative of the elastic critical buckling mode. 
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The value of ηinit can then be entered in the field Max deformation . 

 
 
This procedure will be illustrated in further in this course in the Chapter 6 concerning Stability. 

 

3.3.2. Initial bow imperfection e 0  

 
During a linear calculation, the members are taken to be ideally straight. Using bow imperfections, a 
local curvature can be defined for each element. A normal force in a member will thus lead to additional 
moments. These additional moments shall only be taken into account for members with compressive 
forces. 
 
To obtain correct results using bow imperfections, it is required to refine the number of 1D mesh 
elements . 
 
The local imperfection can be set in the following ways: 

- Simple Curvature 

- According to Buckling Data 

 
Scia Engineer will automatically apply the curvature in the following way, which is in most cases the de-
favourable sense:  
After the first iteration step, the deflection in the middle determines the sign of the initial bow 
imperfection. If there is no deflection the alternating pattern is used and the beam will deform with a 
sinusoidal form through its nodes.  

 

Simple Curvature 

Using this option, a curvature can manually be inputted. This curvature will be used for all members in 
the project. This method is quite convenient when the same type of cross-section (buckling curve) is 
used throughout the project like for example scaffolds, framework,… 
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According to Buckling Data 

A bow imperfection according to buckling data allows the user to specify different curvatures for each 
used buckling data. In the Buckling and relative lengths  properties of a member, the bow 
imperfection can be set. 

 
 
As seen during the 2nd Order calculations, Eurocode 3 Ref.[27] defines the initial bow imperfection 
using the following table: 

 

 

 

 
 

Where L is the member length. 

 

 

 
 
When the options According to code elastic/plastic  are chosen, Scia Engineer will check the 
buckling curve of the member and will apply the specified imperfection automatically on the member. 
This imperfection is always applied which corresponds to Path 2c  of the diagram seen during the 2nd 
Order calculations. 
 
The options According to code elastic/plastic – only if require d will apply the imperfection only if 
the normal force NEd in a member is higher than 25% of the member’s critical buckling load Ncr as 
specified in Eurocode. This corresponds to Path 2b  of the diagram. 
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When selecting Manually input of Bow Imperfection , the imperfection can manually be inputted 
using the tab Buckling Data . 
 
 

 
 
 
This way, the imperfection can be manually inputted for each member. This is in contrast to the Simple 
Curvature  where the same bow imperfection is applied to all members. 
 
When using bow imperfections it is important to set correct reference lengths for buckling since these 
lengths will be used to calculate the imperfection. 
 

Example: Imperfection_Manual.esa  
 
 
In this project, the principle of a bow imperfection is illustrated for a simple beam.   
 
The beam is modelled once as ideally straight (B1). Next the beam is modelled as curved with a 
deflection at midpoint of 200mm (B2). In the third case, the beam is taken as straight and a bow 
imperfection of 200mm is manually set through the Buckling Data (B3). 
 

 
 
 
 
The buckling data of B3 shows the following: 
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The three beams are loaded by a normal force of 5 kN. Those with a deflection of 200 mm, are 
expected to have a moment of 1 kNm  in the middle of the beam. 
 
The moment diagram after a non-linear calculation  shows the following: 
 

 
 
As expected, the beam B1 does not produce a bending moment. Both the curved beam and the beam 
with imperfection yield the 1 kNm.  
This example shows that the bow imperfection corresponds to a curved calculation model. 
 

 
 
 

Example:  Imperfection_Self_Weight.esa  
 
A tube on two supports is loaded by its self weight and a compression load of 20 kN. 
The tube is manufactured in S235, has a cross-section RO 48,3 x 3,2 and length 5m. 
A linear calculation  results in a bending moment of 0,109 kNm : 
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This moment is caused entirely by the self weight of the tube: 
 

Area: 453 mm² = 0,000453 m² 
Volumetric mass: 7850 kg/m³ 
Length: 5m 

� Loading caused by the self weight: 7850 kg/m³ x 0,000453 m² x 9,81 m/s² 
= 34,88 N/m = 0,03488 kN/m 

� Moment caused by the self weight: (0,03488 kN/m x 5m x 5m) / 8 = 0,109 kNm 
 
 
The self weight causes a deformation of 11,659mm 
 

 
 
Due to the fact that the self weight causes this deformation, the compression force of 20 kN will lead to 
an additional moment.  
 
To see this effect in detail, a non-linear analysis  is carried out which takes into account the deflection 
caused by the self weight. The deformation of the self weight can thus be set as a Global 
Imperfection . 
 

 
 
 
The non-linear calculation  results in a moment of 0,342 kNm  
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This value can be calculated as follows: 
  
Imperfection due to the self weight: 11,659mm = 0,011659m 
 
Compression force: 20 kN 

� Additional Moment: 20 kN x 0,011659m = 0,23318 kNm 
Moment caused by the self weight: 0,109 kNm 

� Total moment: 0,109 kNm + 0,23318 kNm = 0,342 kNm 
 
 
It is clear that taking into account the deflection of the self weight has a large influence on the results. 
In this example, the bending moment increases with more than 200%. Especially for slender beams the 
imperfection due to self-weight can be important. 
 

 

3.3.3. Example Global + Bow imperfection 

In this chapter a general example on the Global and bow imperfections in Scia Engineer. 
 

Example: Steel_Depot.esa  
 
To illustrate the use of imperfections, both sway imperfections and bow imperfections are inputted on 
the columns of a steel depot. 
 
The structure has the following layout: 
 

 
 
The diagonals have been inputted as Tension only  members.  
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Inclination functions  are defined According to the code  so the initial sway is calculated 
automatically: 
 

 
 
 
The Buckling data  of the columns is edited to specify Bow Imperfections According to the code : 
 

 
 
Since Global and Local imperfections are used for the columns, a buckling check needs not to be 
executed conform Path 2c  of the diagram seen during the 2nd Order calculations. To take this into 
account in Scia Engineer, the buckling factors can be manually set to a low value so buckling will not 
be normative. 
 
The Fundamental ULS combination according to Eurocode can then be exploded to linear 
combinations which can be imported as Non-Linear combinations. The Bow imperfection is set 
According to Buckling Data  and the Global Imperfections are set through the Inclination functions .  
 
Since sway imperfections need to be considered in one direction at a time, the non-linear combinations 
are taken once with the sway in X-direction and once with the sway in Y-direction. 
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If required, this number of combinations can de doubled to change the sense of the sway 
imperfections. 
 
To obtain correct results for the Bow imperfections, the finite element mesh is refined. 
 

 
 
A 2nd Order  calculation can then be carried out using Timoshenko’s method . 
 
The Steel Code check for the mid columns yields the following result. 
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Since both global and local imperfections have been inputted, only the Section check and the Lateral 
Torsional Buckling check are relevant. In this example, member B9 produces the largest check on the 
compression and bending check. 
 

 
 

3.4. The second order calculation 

3.4.1. Timoshenko 

 
The first method is the so called Timoshenko  method (Th.II.O) which is based on the exact 
Timoshenko solution for members with known normal force. It is a 2nd order theory with equilibrium on 
the deformed structure which assumes small displacements, small rotations and small strains. 
 
When the normal force in a member is smaller than the critical buckling load, this method is very solid. 
The axial force is assumed constant during the deformation. Therefore, the method is applicable when 
the normal forces (or membrane forces) do not alter substantially after the first iteration. This is true 
mainly for frames, buildings, etc. for which the method is the most effective option. 
 
The influence of the normal force on the bending stiffness and the additional moments caused by the 
lateral displacements of the structure (the P-∆ effect) are taken into account in this method.  
 
This principle is illustrated in the following figure. 
 

 
 

M(x) = Hx 
M(L) = HL 

First Order Theory 

 
 

M(x) = Hx + P δ + P ∆x /L 
M(L)= HL + P ∆ 

Second Order Theory 
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The local P-δ effect will be regarded further in this course. 
 
If the members of the structure are not in contact with subsoil and do not form ribs of shells, the finite 
element mesh of the members must not be refined. 
 
The method needs only two steps, which leads to a great efficiency. In the first step, the axial forces 
are solved. In the second step, the determined axial forces are used for Timoshenko’s exact solution. 
The original solution was generalised in Scia Engineer to allow taking into account shear deformations. 
 
The applied technique is the so called ‘total force method’ or ‘substitution method’. In each iteration 
step, the total stiffness of the structure is adapted and the structure is re-calculated until convergence. 
This technique is illustrated in the following diagram. 
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In this figure, the stiffness K is divided in the elastic stiffness KE and the geometrical stiffness KG. The 
geometrical stiffness reflects the effect of axial forces in beams and slabs. The symbol u depicts the 
displacements and F is the force matrix. 
 
The criterion for convergence is defined as follows: 
  ∑�� ,!� + �",!� + �#,!� $ − ∑�� ,!&'� + �",!&'� + �#,!&'� $∑�� ,!� + �",!� + �#,!� $ ≤ 0,005/(*+,-./.01	+34.0) 

 
 
With: ux,i The displacement in direction x for iteration i. 

uy,i The displacement in direction y for iteration i. 
uz,i The displacement in direction z for iteration i. 

 
 
This convergence precision (Precision ratio) can be adapted in the solver setup: 
 

 Start 

Stop 

Calculate KE 

KG = 0 

K = KE - KG 

Solve K.u = F 

Convergence 
in u? 

Calculate KG 

No 

Yes 
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The diagram is illustrated on the following figure. 
 

 
 
 
The choice of the Timoshenko Method and the maximal amount of iterations can be specified through 
Calculation, Mesh > Solver Setup. 
 



Non linear and Stability 
 
 
 
 

26 

 
 
 

 

 
Example:  Timoshenko.esa  
 
In this benchmark example, a frame is calculated both in 1st and 2nd Order using the Timoshenko 
method. The influence of the 2nd Order effects is seen to be significant. 
 
The results are compared with the results from reference [7] ‘Stahl im Hochbau’ p256. 
 
 

 Stahl im Hochbau Scia Engineer 
M21 602.2 ( 227.1 ) kNm  590.33 ( 227.08 ) kNm 
M32 506.0 ( 224.9 ) kNm 485.34 ( 224.86 ) kNm 
M34 779.9 ( 343.0 ) kNm 763.07 ( 342.92 ) kNm 

 
The results between brackets are those for the first order analysis.  
 
The Moment-diagram for the 1st Order analysis  shows the following: 
 

 
 
 
A significant increase of the moments is seen for the 2nd Order analysis : 
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3.4.2. Newton-Raphson 

 
The second method is the so called Newton-Raphson  method (Th.III.O) which is based on the 
Newton-Raphson method for the solution of non-linear equations. 
 
This method is a more general applicable method which is very solid for most types of problems. It can 
be used for very large deformations and rotations; however, as specified the limitation of small strains 
is still applicable.  
 
Mathematically, the method is based on a step-by-step augmentation of the load. This incremental 
method is illustrated on the following diagram: 
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The following figure shows this process graphically. 
 

 
 
In this figure, the tangential stiffness KT is used. The symbol u depicts the displacements and F is the 
force matrix. 
 

 Start 

Stop 

Choose ∆F 
u0 = 0 
F0 = 0 

F = F0 + ∆F 

Determine KT at F0 

Solve KT. ∆u = F 

Convergence 
in u? 

u0 = u 
Determine F0 

No 

Yes 

Any ∆F left? 

u = u0 + ∆u 

No 
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The original Newton-Raphson method changes the tangential stiffness in each iteration. There are also 
adapted procedures which keep the stiffness constant in certain zones during for example one 
increment. Scia Engineer uses the original method. 
 
As a limitation, the rotation achieved in one increment should not exceed 5°. 
 
The accuracy of the method can be increased through refinement of the finite element mesh and by 
increasing the number of increments. By default, when the Newton-Raphson method is used, the 
number of 1D elements  is set to 4 and the Number of increments  is set to 5.  
 
In some cases, a high number of increments may even solve problems that tend to a singular solution 
which is typical for the analysis of post-critical states. However, in most cases, such a state is 
characterized by extreme deformations, which is not interesting for design purposes. 
 
The choice of the Newton-Raphson Method, the amount of increments and the maximal amount of 
iterations can be specified through Calculation, Mesh > Solver Setup. 
 
 

 
 
As specified, the Newton-Raphson method can be applied in nearly all cases. It may, however fail in 
the vicinity of inflexion points of the loading diagram. To avoid this, a specific method has been 
implemented in Scia Engineer: the Modified Newton-Raphson  method. 
 
This method follows the same principles as the default method but will automatically refine the number 
of increments when a critical point is reached. This method is used for the Non-Linear Stability 
calculation and will be looked upon in Chapter 6. 
 
 
In general, for a primary calculation the Timoshenko method is used since it provides a quicker solution 
than Newton-Raphson due to the fact Timoshenko does not use increments. When Timoshenko does 
not provide a solution, Newton-Raphson can be applied. 
 
 

Example: N_R_Beam.esa 
 
This project is used to illustrate the capability of the Newton-Raphson method regarding large 
deformations and large rotations.  
The structure consists of a cantilever beam which is loaded by a moment at the free end. The rotation 
at the free end is given by: 
 

 = 6 ∙ 78 ∙ 9  
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When ϕ=2π, the beam will form a complete circle. The moment required for this rotation is: 
 

6�: = 2; ∙ 8 ∙ 97  

 
The member considered has a length of 10m and a cross-section type IPE200. The parameters in this 
case are: 
 

E = 210000 N/mm² 
L = 10000 mm 
I = 1.943 107 mm4 

 

This leads to a moment M2π=2563,73 kNm . 
 
Since the rotation in one increment is limited to 5°, about 80 increments are needed. To obtain precise 
results, a dense mesh is required. 
 
A calculation using Newton-Raphson with 80 increments and 40 mesh elements for the beam gives the 
following results: 
 

 
 
 
The displacement of nodes  shows the following for fiy : 

 
 
 

 
 
 

Example: N_R_Membrane.esa  
 
This project illustrates the (positive) influence of the membrane forces on the results.  
 
A steel plate is loaded by a surface load, perpendicular to the member system-plane. A 1st Order  
calculation gives the following deformations: 
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A 2nd Order  calculation using Newton-Raphson  will take into account the development of membrane 
forces in the plate. These tensile membrane forces will have a positive effect on the stiffness on the 
plate and will thus reduce the deformations.  
 
The results are showed below.  
 

  
 
 
Remark 
 
As explained before, Timoshenko is not valid for high deformations. So for this example, Timoshenko 
would lead to incorrect results and this method does not take into account (positive) influence of the 
membrane forces on the results. The deformations calculated with Timoshenko are the following: 
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4. Physical Non-Linearity 

 
When the stresses are dependent on the strains in a non linear way, the non linearity is called a 
physical non linearity. 
 
In Scia Engineer, the following types of physical non linearities have been implemented: 

- Plastic Hinges  for Steel Structures 

- Physical Non-Linear analysis  for Concrete Structures 
 
 

4.1 Plastic Hinges for Steel Structures 
 
When a normal linear calculation is performed and limit stress is achieved in any part of the structure, 
the dimension of critical elements must be increased. If however, plastic hinges are taken into account, 
the achievement of limit stress causes the formation of plastic hinges at appropriate joints and the 
calculation can continue with another iteration step. The stress is redistributed to other parts of the 
structure and better utilization of overall load bearing capacity of the structure is obtained. 
 
The material behaves linear elastic until the plastic limit is reached after which it behaves fully plastic. 
The σ-ε diagram thus has the same shape as the Moment-Curvature diagram: 
 

M

k

Mp

 
 
The full plastic moment is given as Mp, the curvature as k. 
 
In Scia Engineer, a plastic moment can only occur in a mesh-node . This implies that the mesh needs 
to be refined if a plastic hinge is expected to occur at another location than the member ends. 
 
The reduction of the plastic moment has been implemented for symmetrical I-shaped cross-sections 
according to the following codes: EC3, DIN 18800 and NEN 6770.  
 
There is off course a risk when taking plastic hinges into account. If a hinge is added to the structure, 
the statically indeterminateness is reduced. If other hinges are added, it may happen that the structure 
becomes a mechanism. This would lead to a collapse of the structure and the calculation is stopped. 
 
On the other hand, plastic hinges can be used to calculate the plastic reliability margin of the structure. 
The applied load can be increased little by little (e.g. by increasing the load case coefficients in a 
combination) until the structure collapses. This approach can be used to determine the maximum load 
multiple that the structure can sustain. 
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To take into account Plastic hinges for Steel Structures, the functionality Nonlinearity > Steel > 
Plastic Hinges  must be activated. 
 

 
 
 
The choice of code which needs to be applied can be specified through Calculation, Mesh > Solver 
Setup. 
 

 
 
 

Example:  Plastic_Hinges.esa  
 
In this project, a continuous beam is considered. The beam has a cross-section type IPE 330 and is 
fabricated in S235.  
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According to Eurocode 3, the plastic moment around the y-axis is given by: 

 6<=,",> = ?@A,B∙CBDEF  
 
 

For the beam considered this gives the following: 
 

fy = 235 N/mm² 
Wpl,y =  6.28 105 mm³ 
γM0 = 1.1 
⇒ Mpl,y,d = 134.2 kNm 
 
 

A linear analysis  shows the following Moment-diagram: 
 

 
 
 
A non-linear analysis  taking into account plastic hinges gives the following result: 
 

 
 
 
When the load is increased further, another plastic hinge will form in the middle of a span thus creating 
a mechanism and showing the next window after calculation: 
 

 
 

 

4.2 Physical Non-Linear analysis for Concrete Struc tures 
This topic is regarded in detail in the course “Advanced Training Concrete”. 
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5. Local Non-Linearity  

 
The local non linearities can be defined for 1D members, connections between 1D members, 2D 
members and supports. 
 
The following types have been implemented in Scia Engineer: 

- Beam local nonlinearity 

- Beam local nonlinearity including initial Stress 

- Non-linear member connections 

- Support nonlinearity 

- Pressure only elements 

- 2D Membrane Elements 

 

5.1. Beam Local Nonlinearity – also available in th e concept edition 
The options described in this chapter are also possible with a Concept edition . So the Professional 
edition is not required for this chapter. 
 
To input local nonlinearities for 1D members, the functionality Nonlinearity > Beam local nonlinearity  
must be activated. 
 

 
 

The non-linearity can then be inputted in the  menu through  
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The following types are available: 

- Pressure only 

- Tension only 

- Limit force 

- Gap element 
 
All those options are explained with examples in the chapters below. 
 

5.1.1 Members defined as Pressure only / Tension on ly 

Pressure only: the member is only active under pressure (i.e. strut, …) 
 
Tension only: the member is only active under tension (i.e. anchor, diagonal, …) 
 
 
When using this type of beam non-linearity, it can happen that numerically a very small 
pressure/tensile force remains in the member, mostly due to the self-weight. This value will always be 
negligible compared to the other force components in the member. 
 
 

Example: Tension_Only.esa  
 
A 2nd Order  calculation is executed using Newton Raphson , including global imperfections. 
The diagonals are designated as ‘Tension-only ’ members. 
 
The normal forces for a linear analysis  show that extreme compression results are obtained in the 
diagonals. This will inevitably lead to failure due to buckling. 
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The normal forces for the non-linear analysis  shows that diagonals are now only subjected to tension 
thus buckling will not occur anymore. Only very small compression forces will appear in the diagonals. 
 
 

 

Notes: 

- It is important to keep in mind that ‘Tension only’ does not change anything for shear forces and moments. 
The only component which cannot occur is compression, but the member can still be subjected to bending, 
torsion,... 

To specify that a member can only be subjected to normal forces, the FEM type of the member can be set to 
axial force only. 
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When using this, the user must be absolutely sure that bending effects cannot occur in reality! 

 
-The Calculation protocol for the Nonlinear calculation shows extra information concerning the applied 
nonlinearities, number of iterations per combination,… 
 

 
 
 
 

Example: Mechanism.esa 
 
When using Beam Nonlinearities, it is important to make sure that not too many elements are 
eliminated. 
 
A common error is the creation of a mechanism due to the fact too many elements have been 
designated tension only/pressure only and thus no solution can be found. This principle is illustrated in 
the following project. 
 
A steel frame has been modelled with hinged connections between the elements. The diagonals have 
been specified as Tension only . 
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Due to for example a roof load, both diagonals are subjected to compression. This is not possible for 
Tension only  members so both members are eliminated causing a global instability of the frame. 
 

 

 

5.1.2 Members with Limit Force 

A member with limit force acts in the structure until a specified limit is reached after which the member 
will be eliminated from the calculation or yields plastically. 
 

 
 
The Direction  is used to specify in which zone the limit acts: the tension zone or the compression 
zone. 
 
When the limit is reached, it can be specified in the Type  field how the member should act. The 
member can be eliminated from the structure (Buckling ) or the member can stay in the structure but 
with the limit force as maximal axial force (Plastic yielding ). 
 
The limit itself is defined in the field Marginal Force . A negative value must be specified for a 
compression limit and a positive value for a tension limit. 
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Example:  Limit_Force.esa  
 
In this project, a frame is modelled in which one diagonal has a compression limit  of -30 kN. 
 
For the left frame, the type is set to Buckling , for the right frame the type is set to Plastic yielding . 
 

 
 
 
 
A linear analysis  shows the following normal forces in the diagonals of both frames: 

 
 
A non-linear analysis , taking into account the limit force gives the following results for the normal 
forces: 

 
 
In the left frame, the diagonal has buckled so the tensile force in the remaining diagonal is augmented. 
In the right frame, the diagonal stays in the structure but yields plastically and thus acts at the limit 
force of -30 kN. 
 
The deformed structure for the non-linear analysis  shows the following: 
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Due to the fact one diagonal has buckled in the left frame, larger horizontal deformations occur. 
 

  

5.1.3 Members with gaps 

There are various connection and support conditions used in a real structure. It may happen that a 
beam is not attached rigidly to the structure but "starts its action" only after some initial change of its 
length. The beam thus has to have a certain translation in its local x-direction before it becomes active. 
This behaviour can be inputted using ‘gap’ elements. 
 

 
 
The Type  field is used to specify if the member is active only in compression, only in tension or in both 
directions. 
 
The value of the translation can be inputted in the Displacement  field. The gap can be defined at the 
beginning or at the end of the beam using the Position  field. 
 
Gap members in tension only can for example be used to model a rope: the rope can only work in 
tension but becomes active only after a certain translation. Gap members in both directions are 
frequently used in scaffolding structures. 
 
 
 

5.2. Beam Local Nonlinearity including Initial Stre ss 
 
To input local nonlinearities for 1D members, including initial Stresses, following functionalities must be 
activated: 

- Nonlinearity  
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- Nonlinearity > Beam local nonlinearity  

- Nonlinearity > 2 nd Order – Geometrical nonlinearity  and  

- Initial Stress   

 

 
 

The non-linearity can then be inputted in the  menu through  
 

 
 
Two extra types are now available: 

- Members with Initial Stress 

- Cable Elements 
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5.2.1 Members with Initial Stress  

 
Tensile forces in elements augment the stiffness of the structure. Compression forces reduce the 
stiffness. 
 
 
Initial Stress is regarded as follows: 

- The element in question is taken from the structure. 

- The initial Stress is put on the element through the defined axial force. 

- The element is put back into the structure. 
It is clear that, when the element is inserted into the structure, the initial stress will partly be given to 
other members thus the inputted force will not stay entirely in the member in question. 
 

Notes: 

- A positive axial force signifies a tensile force; a negative axial force signifies a compression force. 

- Initial Stress is mostly used in conjunction with a 2nd Order analysis. 

- Initial Stress is the only local non-linearity taken into account in a Linear Stability Calculation. This type of 
calculation will be regarded in Chapter 6. 

 
To take the inputted Initial Stresses into account for the calculation, the options Initial Stress  and 
Initial Stress as input  must be activated through Calculation, Mesh > Solver Setup. 
 

 
 
 

Example: Initial_Stress.esa 
 
In this project, a simple frame is modelled. The diagonal has a RD30 section and is given an Initial 
Stress by means of a tensile force  of 500 kN.  
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In the left frame, the Initial Stress will immediately be distributed to the column. In the right frame, the 
extra support will prohibit this. 

 
A non-linear analysis , taking into account the initial stress gives the following results for the normal 
forces: 

 
 
As specified, in the left frame, the initial stress is immediately distributed to the rest of the structure so 
the tensile force of 500 kN is not found entirely in the diagonal. In the right frame, the force cannot be 
distributed due to the support so the 500 kN stays in the diagonal. 

 
This principle is even clearer when looking at the deformed mesh for the non-linear analysis :  
 

 
 

 
 
In theory, when using correctly defined values of the cross-section properties (surface A, moment of 
inertia I, modulus of Young E), a Beam non-linearity with Initial Stress can also be used to model 
straight cables with large pre-stress forces. Both Timoshenko  and Newton-Raphson  methods can be 
applied in this case. 
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In general however, for cables the use of the specific Cable element  is advised in conjunction with the 
Newton-Raphson  method. 

 
 

5.2.2 Cable Elements – Not available in the Profess ional edition 

This options needs module esas.12 and this module is included in the expert edition. 
 
A Cable element is an element without bending stiffness (Iy and Iz ≅ 0). During the solving of the 
equations this is taken into account so no bending moment will occur in the element. The 
displacements (in the intermediate nodes) have thus been calculated without bending stiffness. 
 
A Cable element allows a precise analysis of cables. For slack cables, Scia Engineer allows the 
definition of the initial curved shape of the cable. 
 
A cable can be defined in three ways: 

1) A Straight  cable. 
2) A Slack cable with an initial shape caused by the Self-weight . 
3) A Slack cable with an initial shape caused by a distributed load Pn. 

 
A straight cable is defined by choosing the option Straight  at “Initial mesh” 
 

 
 
When choosing Calculated  for Initial mesh, the cable acts as slack.  
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The initial shape will be in equilibrium in relation to the specified load on the cable: either the self-
weight  or a distributed load Pn. 
 
When activating the option Self weight the specified load will be the self weight of the cable. 
 
When choosing for a distributed load Pn, it can be specified that the load is not vertical but is rotated. 
This can be inputted through the angle Alpha x , the rotation angle around the local x-axis. For a 
default slack cable this parameter will be zero. 
 
 
When using a calculated initial mesh, the program generates a curves mesh, defining an arc of circle 
based on the two ends of the member and the sag in the middle of the member. 
The sag is calculated as follows: 

 

G = H ∙ 7�8 ∙ J  

 
 

    J = tension in the cable (positive value) 
   G = offset of cable at mid-span 
   7 = span length H = line load on the cable (positive = downwards ) applied perpendicularly  to the axis 

of the member. H can be equal to KL or MN or KL + MN 
  
 
The user can thus define a specific initial shape by specifying the value for the sag f.  Using the above 
formula, this leaves two unknowns: Pn and N. By choosing the value for one, the other is defined and 
the initial shape is known. 
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Note 

- the distributed load q is always perpendicularly to the member axis. The reason for that is, that 
only the component of the load that is acting perpendicularly to the beam is affecting the 
calculation of the sag. However, this implies that the value of sag will be overestimated when the 
member is not horizontal. 
Workaround: disable the self weight and input it as KL instead, with KL = MN ∙ -0/O where O is the 
angle between the member axis and the horizontal plane. 

- There is a limit value for the sag value. The program will not apply a sag value larger then 7 4⁄ . If 
the result of the formula above is higher, G = 7 4⁄  will be used. 

- The input of the cable element only defines the initial shape. Afterwards the cable can be 
loaded by real loads. 

- The calculations are executed on the deformed shape. This indicates that the eventual 
deformation of a cable is calculated from the slack shape and not from the initial straight 
shape. 

- The deformed mesh can be used to show the true deformation of the cable. 

- For a precise analysis, the finite element mesh on a cable element needs to be refined. To 
avoid unnecessary refinements for all members of the structure, the mesh of cable 
elements can be refined separately through Setup > Mesh > Average size of cables, 
tendons, elements on subsoil. 
 

 
 
 

 

Example: Cable_Equilibrium.esa  
 
In this project, a cable analysis is performed once with a pre-stress force and once without. The cable 
has following properties: 
 

Length of the cable:   20 m 
Section of the cable:   0.001 m² 
E-module of the material:   2.1 1011 N/m² 
Loading q on the cable:  1 kN/m 

  
 
Result of Scia Engineer for initial pre-stress N init =1000 kN 
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wmax = 49.8 mm 
N = 1003.51 kN 
 

Check: 
 
- Moment in the middle of the cable: H ∙ 7²8 − J ∙ S�T = 50 − 49.97	 ≈ 0 

 
- Normal force in the cable: 
 
 

For the calculation of the strain, the shape of the displacement is taken as parabolic. This gives the 
following formula: 

 

s

h

b

 

 / ≈ YZ² − '[� ℎ² 
The strain ε in the cable can then be written as: 

 

] = �1 + 16 ∙ ℎ²3 ∙ /² − 1 = �1 + 16 ∙ S�T �
3 ∙ `² − 1 = 1.653346 ∙ 10&a 

 J> = ] ∙ b ∙ 8 = 3.472	cJ  
 
N = Ninit + Nd = 1000 kN + 3.472 kN = 1003.47 kN ≈ 1003.55 kN 

 
 

 
Result of Scia Engineer for initial pre-stress N init = 0 kN 

 
wmax = 329.7 mm 
N = 151.93 kN 

 
Check: 
 
- Moment in the middle of the cable: 

  
d∙e²f − J ∙ S�T = 50 − 50.09	 ≈ 0  

 
- Normal force in the cable: 

 ] = Y1 + '[∙�²�∙g² − 1 = Y1 + '[∙hijkl
�∙=² − 1 = 7.24418 ∙ 10&m 

 
 J> = ] ∙ b ∙ 8 = 152.13	cJ  
 
N = Nd = 152.13 ≈ 152.01 kN 
 
The deformation of both cables is shown in the following figure: 
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The following results are obtained for the normal forces in the cables: 
 

 
 

 
 
 

 
Example:  Cable_Polygonal.esa  
 
In this benchmark project a polygonal cable is loaded by a Point Load. The value of the Point Load is 
altered between 3 kN, 5 kN, 10 kN, 15 kN and 20 kN. 
 
For each case, the maximal deformation and the normal force are compared with benchmark results 
from Petersen, ref [9]. 
 
 

 
 
 
The following graphs give an overview of the obtained results out of Scia Engineer: 
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The following table gives an overview of the obtained results in comparison with Peterson: 
 

F 3.0 kN 5.0 kN 10.0 kN 15.0 kN 20.0 kN 
N Petersen [kN] 7.48 12.29 23.80 34.69 45.08 
N Scia Engineer [kN] 7.48 12.29 23.79 34.68 45.07 
∆f Petersen [m] 0.0233 0.0392 0.0744 0.1072 0.1375 
∆f Scia Engineer [m] 0.0240 0.0392 0.0747 0.1074 0.1378 

 

 
 

Example: Cable_Distributed.esa  
 
In this benchmark project a pre-stressed cable is loaded by a Distributed Load. The value of the 
distributed load is altered between 1.7 N/m and 6.33 N/m. 
 
For both cases, the maximal deformation and the normal force are compared with benchmark results 
from Petersen, ref [9]. 
 
The pre-stress force in the cable is 3,8 kN. 

 
 
The following table gives an overview of the obtained results: 
 

q 1.7 N/m 6.33 N/m 
N Petersen [kN] 3.83 4.23 
N  Scia Engineer [kN] 3.84 4.24 
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∆f Petersen [m] 0.15000 0.50615 
∆f  Scia Engineer [m] 0.14969 0.50482 

 

 
 

Example: Cable_InitalShape.esa 
 
To illustrate the calculation of the initial shape, a simple cable element is modelled with following 
properties: 
 

Length of the cable:   20 m 
Section of the cable:   0.001 m² 
E-module of the material:   2.1 x 1011 N/m² 
 

 
The initial shape will be calculated with following properties: 

 
Normal force:    200 kN 
Distributed load:    10 kN/m 
 

 
 
Afterwards the cable is loaded by a line force of 1kN/m. 
 
Scia Engineer gives the following results for the displacement in the z-direction: 
 

 
 
Those are the displacements of the distributed load of 1kN/m.  
 
This initial shape can also be calculated with following formula: 
 

n = H ∙ 7²8 ∙ G  

 

G = H ∙ 7²8 ∙ n = 10	cJ ∙ (20	�)²8 ∙ 200	cJ = 2.5� = 2500�� 

 
The total deformation in the middle of the cable is than: 
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Total deformation = -2500mm + 8.0 mm = -1492 mm: 
 

 

 

 

 

 

 
 

Example: Guyed_Mast.esa 
 
To illustrate the application of cables, a guyed mast is modelled. The mast is supported by several 
cables which have a pre-stress force of 5 kN and an initial shape due to the self-weight . 
 

 
 
The deformed mesh for Non-Linear combination NC9 for example shows the following: 
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Detailed calculation information can be found in the Calculation Protocol : 
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5.3. Non-Linear Member Connections 
 
When inputting hinges on beam elements, it is possible to input a non-linear function for each degree 
of freedom (ux , uy , uz, fix , fiy , fiz ). The function can signify the relation between moment and rotation 
or force and displacement. 
 

 
 
When using non-linear functions, it is very important to input a relevant linear stiffness. This value is 
used during the first iteration of the non-linear calculation (and during a linear calculation).  
 

The non-linear functions can be defined through >  > 
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For member connections, the non-linear functions can be defined for translation or rotation. When 
defining a function, it is very important to check the signs of the function values. The defining 
magnitudes for non-linear rotation functions are the internal forces, for non-linear translation functions 
the displacements. 
This implies that these functions are inputted in the first and third quadrant. 
 
For the end of the function, it is possible to select one of three options: 

- Free: When the maximal force is reached, it stays at that value and the deformation will rise 
uncontrolled. 

- Fixed: When the maximal deformation is reached, it stays at that value and the force component 
will rise. 

- Flexible: The relation between force component and deformation is linear. 

 
Scia Engineer also allows creating a new function from the already defined functions to provide an 
easy input of complex functions. 
 
 

Example: Connection.esa 
 
In this example, an industrial hall is calculated using algorithms to calculate the moment-rotation 
diagram for bolted and welded beam-to-column connections. Scia Engineer allows the calculation of 
these diagrams and the automatic application of the diagram as a non-linear spring function for 
member connections. For the theoretical background, reference is made to the “Advanced Training 
Steel” and ref. [14]. 
 
The geometry of the structure is shown in the following figure: 
 

 
 
The structure is calculated in 2nd Order using Timoshenko’s  Method. The diagonals have been set as 
Tension-only . 
 
 
In node N2 a bolted beam-to-column connection is modelled: 
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The Moment-Rotation diagram is calculated by Scia Engineer using the algorithm of the EN 1993-1-8. 
 

 
 
 
 
Together with the calculated diagram, automatically a non-linear function is created: 
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The function characterizes both tension-on-top and tension-at-bottom. 
 
This function can then be assigned to the hinge defined in node N2: 
 

 
 

 
 

5.4. Support Nonlinearity 
Scia Engineer allows the following types of non-linear supports: 

- Tension only / Pressure only supports 

- Nonlinear springs for supports 
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- Friction supports 
 

5.4.1. Tension only / Pressure only Supports 

To input nonlinearities for supports, the functionality Nonlinearity > Support nonlinearity  must be 
activated. 

 
 
Supports with tension can be automatically eliminated. This is mostly used for slabs on subsoil, column 
bases of for example scaffoldings, struts, … 
 
The following types of supports can be eliminated if tension occurs: 

- Nodal Support 

- Line Support 

- Subsoil 
 
For Nodal Supports or Line Supports it is possible to specify a translation degree of freedom as ‘Rigid 
pressure only’  or ‘Flexible Pressure only’ . 
 
To eliminate supports in pressure (and obtain a Tension-only  support), the nodal support can be 
rotated 180°. 
 
Subsoils are always regarded as Pressure-only  for a non-linear calculation. No specific input has to 
be made.  
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Example: Subsoil.esa 
 
 
In this example, a slab on subsoil is calculated. The slab is loaded by a Point Force in the middle.  
The deformed mesh for the linear analysis  shows the following: 
 
 

 
 
 
Especially in the corners, tensile contact stresses are expected: 
 

 
 
A non-linear analysis , taking into account the pressure-only characteristic of the subsoil shows the 
following deformation: 
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As can be seen, the slab will rise at the corners so no more tensile contact stresses are obtained: 
 

 
 
The pressure stresses in the middle have increased which is expected when the slab can rise at the 
corners. 

 

Note: 

- When using subsoil, it is important to adequately refine the mesh in order to produce precise results. 
- When calculating following the Winkler theory, the Pasternak values (C2) must be set to zero. 

 

 
 

5.4.2 Nonlinear Springs for Supports 

As seen for nonlinear member connections, it is also possible to use non-linear functions for supports.  
 
For each degree of freedom (X, Y, Z, Rx, Ry, Rz) a nonlinear function can be inputted. The function 
can signify the relation between moment and rotation or force and displacement. 
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When using non-linear functions, it is very important to input a relevant linear stiffness. This value is 
used during the first iteration of the non-linear calculation (and during a linear calculation). 
 
The definition of the nonlinear functions is exactly the same as seen with nonlinear member 
connections. 
 
In addition to nodal supports, a non-linear function can also be used for a subsoil under a plate. 
 
 

Example: Support_Function.esa 
 
In this example, the use of a non-linear function for a support is illustrated. A simple beam on two 
supports is modelled.  
 

 
 
The translation Z  of both supports has been defined as a non-linear function: 
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The beam is loaded by a point force at one end. The value of the point force is taken as 1kN and 
1.4kN. 
 
A non-linear analysis  shows the following deformation for the load of 1kN: 
 

 
 
This value can manually be approximated as follows: 
 

mmNN
NN

mm
Uz 14,53)6281000(

6281328
100 −=+−

+−
−=  

 
 
For the load of 1.4 kN, the fixed end of the function is reached thus the maximal deformation of 100mm 
is obtained: 
 

 
 

 
 

 

 

Example: Pallet_Racking.esa 
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In this example, the calculation of a pallet racking system is shown according to ref. [10] Eurocode 
ENV 1993-1-1 and ref. [11] FEM 10.0.02. This last reference gives field test methods which allow the 
definition of moment-rotation diagrams for beam-to-column connections and column supports. 
 
The beam-to-column connections and column supports can be defined by means of non-linear 
functions. 
 
 

 
 
The following non-linear spring is defined for the column supports: 
 

 
 
The beam-to-column connections are defined by the following non-linear characteristic: 
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Example: Culvert.esa 
 
This project illustrates the use of non-linear functions to model for example the soil under a culvert. 
The culvert has the following shape: 
 

 
 
Non-linear supports have been defined with appropriate functions to model the behaviour of the soil: 
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A non-linear analysis gives the following deformation pattern for combination NC2: 
 
 

 
 

 

5.4.3 Friction Supports 

Friction supports can be used to model the fact that a reaction component is dependent on another 
component. The horizontal component is for example dependent on the vertical component. When the 
friction force is surpassed, the support slips through resulting in large deformations. 
 
To input friction supports, both the functionalities Nonlinearity > Support nonlinearity/Soil spring 
and Friction Support/Soil spring  must be activated. 
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When entering a nodal support, the option Friction  can be chosen for the translational degrees of 
freedom (X, Y, Z). 
 

 
 
 
The option From Reaction  is used to specify which force component causes the friction force. 

 
X, Y, Z: The final limit force can be calculated from the reaction in a specified direction. If a 

support in the X-direction is being defined, it can be said that the friction force 
should be determined from the reaction calculated in either the Y or Z direction. The 
friction force is calculated from the following formula: 

  zx Rmju ⋅  

 
XY, XZ, YZ: The final limit force can be calculated as a compound friction. Only one of the stated 

options is offered for each direction. E.g. if a support in the X-direction is being 
defined, it can be said that the friction force should be determined from the reactions 
calculated in the Y and Z direction. The friction force is calculated from the following 
formula: 
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   22
zyx RRmju +⋅  

 
X+Y, X+Z, Y+Z: The same as above applies here. A different procedure is however used to   

calculate the limit force. E.g. for a friction support in the X-direction the following 
formula is employed: 

  zxyx RmjuRmju ⋅+⋅  

 
In these formulas, mju  specifies the coefficient of friction. 
 
In the field C flex , the stiffness of the support can be inputted. 

 

Note: 

- Friction can be inputted in one or two directions. It is not possible to define friction in all three directions 
since otherwise the "thrust" cannot be determined. 

- When simple friction (X, Y, Z) is defined in two directions, the option Independent is available. This specifies 
that the friction in one direction is independent on the friction in the other direction. 
 
- Composed friction (e.g. YZ or Y+Z) can be specified only in one direction. 

 
Friction supports can be used for several types of structures. Nearly every support which isn’t rigidly 
connected to the surface on which it stands is subjected to friction. Examples include base jacks of 
scaffolding structures, supports on an inclined surface, pipes in boreholes,… 
 
 

Example: Scaffolding.esa 
 
This project illustrates the use of friction supports for a scaffolding structure. The scaffold has the 
following geometry: 
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The base jacks are inputted as friction supports. Since a base jack, by default, is not connected to the 
surface, the Z-direction is defined as rigid Pressure-only . Both horizontal degrees of freedom X and Y 
are defined as Friction , dependent on the reaction Z.  
 

 
When large wind loads are taken into account, for example due to netting, large horizontal reaction 
forces are expected in the base jacks. When these reactions surpass the friction force, the support 
slips through. 
 
After a non-linear  analysis  of the scaffold, the deformed mesh  for combination NC5 shows the 
following: 

 
 
 
In the middle base jacks, the friction force is clearly surpassed and thus the supports slip through. To 
avoid this, the reaction in Z-direction must be augmented thus extra dead weight like ballast will be 
required or the base jacks must be fixed to avoid slipping. 

 

Note: 
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The functionality ‘Nonlinear Line Support’ defines a specific type of soil spring developed for the Pipfas 
project (Buried Pipe Design).  

 

 
 

5.5 2D Elements 

5.5.1 2D Membrane Elements – Not in Professional Ed ition 

This option is implemented in module esas.37 and included in the Expert edition. So with the 
Professional edition the option of Membrane elements as described in this chapter, will not be possible. 
 

 
Membrane elements are defined as shell elements which have no flexural stiffness and no axial 
compression stiffness.  
 
Membrane elements can thus be used to model canvas, nets, etc. that are subjected to axial tension. 
 
To obtain realistic results, a 2nd Order calculation needs to be executed using the Newton-Raphson 
method. 
 
To input 2D membrane elements, the functionalities Nonlinearity > 2 nd Order – Geometrical 
nonlinearity  and Membrane Elements  must be activated. 
 
 

 
 
 
When defining the 2D element, the option Membrane  must be chosen at FEM model.. 
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Note: 

- Membrane elements can only be modelled in a General XYZ environment. 
 
- Due to the fact the flexural rigidity is zero, no ribs, orthotropic parameters or physical non-linear data can 
be inputted on a membrane element. 
 
- Since a membrane element has no axial compression stiffness, no concrete calculation can be performed on 
this type of element. 

 
 

Example:  Membrane.esa 
 
In this project, a textile canvas is modelled. At the four corners of the canvas, steel cables are 
attached. Two cables are subjected to a tensile force of 50kN in horizontal direction. 
 

 
 
 
Since the canvas has an initial position 0,5m lower than the endpoint of the cables, the canvas will first 
be pulled straight. 
 
Since both cable  and membrane  elements are used, a 2nd Order non-linear analysis  is executed 
using the Newton-Raphson  method. 
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The deformed mesh for the non-linear  analysis shows that the canvas has been pulled straight: 
 
 

 
 
When the scale of the results is augmented, the typical deformation of the membrane element can 
clearly be seen: 
 
 

 
 
The tensile forces for the cable elements are shown on the following figure: 
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The principal  membrane force n1 shows the tensile forces in the canvas: 
 
 

  
 
 
In the same way, n2 can be shown: 
 

  
 
 
The results show the 2nd Order effect: due to the tensile forces in one direction, the canvas obtains a 
stiffness which results in compression membrane forces. 
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5.5.2. Pressure only 

To input pressure only for 2D elements, the functionality Nonlinearity and Press only 2D members 
must be activated. 
 

 
 
With this option, tension in 2D elements can be automatically eliminated. This is mostly used for 
masonry elements. In below some examples are shown to clarify this option.  
 
 

Example: PressureOnly1.esa 
 
This project illustrates the use of pressure only elements. 
In this project two 2D-elements are modelled. The first one is modelled as an isotropic element with 
no nonlinearity, the second one is a pressure only element: 
 

 



Advanced Training 
 

75 

  
 
 

When calculating those elements, for every mesh element a certain orthotropy will be inserted. At the first 
iteration step all the pressure only elements, will be calculated as an isotropic element. After the first 
calculation, Scia Engineer will input another stiffness on all elements in tension. So a certain orthotropy will 
be created. With this stiffness the tension capacity of this element will decrease. After adapting the 
orthotropic parameters a new calculation will be performed. After this second iteration step again the 
elements in tension will get another stiffness. This process will be repeated until equilibrium is reached. 
 
 
The difference between the isotropic and orthotropic elements can be clearly view looking at the normal 
force ny for these members: 
 

 
 

 
In these results the real pressure of this element is visible for the right element. Looking at the trajectories of 
this normal force, the trajectory of the pressure force will be even more visible: 
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Example: PressureOnly2.esa 
 
When looking at the pressure diagonals in a reinforced 2D concrete element, ribs can be imported as 
reinforcement.  
 
In this example a plate with a bearing support is inserted with two ribs acting as the reinforcement of 
the plate: 

 
 
 
Looking at the results of this 2D element, the pressure diagonals inside this element are clearly visible: 
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6. Stability Calculations 

 
A stability calculation calculates the global buckling mode (eigenmode) of a structure under the given 
loading. In addition, the ratio between the buckling load and the applied load is given. 
 
Stability calculations are used to obtain an insight into the buckling mechanisms of a structure, to 
calculate the buckling length of a member for use in the Steel Code Check, to verify if 2nd Order 
calculations are required,… 
 

6.1 Stability Combinations 

As seen for a non-linear analysis, the principle of superposition is also not valid for a Stability 
calculation. The combinations have to be assembled before starting the calculation. In SCIA.Engineer, 
this is done by defining Stability Combinations . 
 

 
 
A stability combination is defined as a list of load cases where each load case has a specified 
coefficient. 
 

 
 
As specified for the non-linear combinations, it is possible to import the linear combinations as stability 
combinations. 
 

6.2 Linear Stability 

During a linear stability calculation, the following assumptions are used: 

- Physical Linearity. 

- The elements are taken as ideally straight and have no imperfections. 

- The loads are guided to the mesh nodes, it is thus mandatory to refine the finite element mesh in 
order to obtain precise results. 

- The loading is static. 

- The critical load coefficient is, per mode, the same for the entire structure. 

- Between the mesh nodes, the axial forces and moments are taken as constant. 
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The equilibrium equation can be written as follows: 
 
  opq − prs ∙ � = t 
 
The symbol u depicts the displacements and F is the force matrix. 
 
As specified in the theory of the Timoshenko method, the stiffness K is divided in the elastic stiffness 
KE and the geometrical stiffness KG. The geometrical stiffness reflects the effect of axial forces in 
beams and slabs. 
 
The basic assumption is that the elements of the matrix KG are linear functions of the axial forces in the 
members. This means that the matrix KG corresponding to a λth multiple of axial forces in the structure 
is the λth multiple of the original matrix KG. 
 
The aim of the buckling calculation is to find such a multiple λ for which the structure loses stability. 
Such a state happens when the following equation has a non-zero solution: 
 

 opq − u ∙ prs ∙ � = 0 
 

 
In other words, such a value for λ should be found for which the determinant of the total stiffness matrix 
is equal to zero: 
 

 pq − u ∙ pr = 0 
 

Similar to the natural vibration analysis, the subspace iteration method is used to solve this eigenmode 
problem. As for a dynamic analysis, the result is a series of critical load coefficients λλλλ with 
corresponding eigenmodes. 
 
To perform a Stability calculation, the functionality Stability  must be activated.  
 

 
 

In the results menu, the λ values can be found under the caption  
The number of critical coefficients to be calculated per stability combination can be specified under 
Setup  > Solver . 
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Note: 

- The first eigenmode is usually the most important and corresponds to the lowest critical load 
coefficient. A possible collapse of the structure usually happens for this first mode. 

- The structure becomes unstable for the chosen combination when the loading reaches a value 
equal to the current loading multiplied with the critical load factor. 
 
- A critical load factor smaller than 1 signifies that the structure is unstable for the given loading. 
 
- Since the calculation searches for eigen values which are close to zero, the calculated λ values can 
be both positive or negative.  
A negative critical load factor signifies a tensile load. The loading must thus be inversed for buckling 
to occur (which can for example be the case with wind loads). 
 
- The eigenmodes (buckling shapes) are dimensionless. Only the relative values of the deformations 
are of importance, the absolute values have no meaning. 
 
- For shell elements the axial force is not considered in one direction only. The shell element can be 
in compression in one direction and simultaneously in tension in the perpendicular direction. 
Consequently, the element tends to buckle in one direction but is being ‘stiffened’ in the other 
direction. This is the reason for significant post-critical bearing capacity of such structures.  
 
- Initial Stress is the only local non-linearity taken into account in a Linear Stability Calculation. 
 
- It is important to keep in mind that a Stability Calculation only examines the theoretical buckling 
behaviour of the structure. It is thus still required to perform a Steel Code Check to take into account 
Lateral Torsional Buckling, Section Checks, Combined Axial Force and Bending,… 

 
 

Example: Buckling_Frame.esa  
 
A stability analysis is performed on a steel frame. The first three buckling modes are calculated and the 
buckling loads are compared to the analytical results from ref.[26] to obtain a benchmark for the 
stability calculation of Scia Engineer. 
 

 
 
 
 
To obtain precise results, the number of 1D elements is refined through Setup  > Mesh . 
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Under Setup  > Solver  the Number of critical values  can be specified. In addition, the Shear Force 
deformation  is neglected to have a good comparison with the analytical results. 
 

 
 
After executing a Stability calculation, the following critical load coefficients are obtained: 
 

 
 
The corresponding buckling modes can be shown under Displacement of nodes  by viewing the 
Deformed mesh  for the Stability Combination . 
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Buckling mode 1 – Critical load factor λ = 2,21 
 

 
 
 
 
Buckling mode 2 – Critical load factor λ = 2,89 
 

 
 
 
 
 
Buckling mode 3 – Critical load factor λ = 3,53 
 

 
 
 
The loading F on each column is 100 kN so the critical buckling load Ncr can be calculated as: 
 

 J�� = u ∙ t  
 

This gives the following results which can be compared to the analytical calculation: 
 
  

Ncr for Scia Engineer Ref.[26] 
Buckling Mode 1 221 kN 221.5 kN 
Buckling Mode 2 289 kN 289.6 kN 
Buckling Mode 3 353 kN 353.8 kN 
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Example: Buckling_Arch.esa  
 
When calculating for example an arched steel bridge, one of the required parameters for a Steel Code 
Check is the buckling length of the arch. Using a stability calculation, the buckling factor of any member 
can be obtained. 
 
As an example, a steel parabolic arch is modelled with two fixed end points. The arch has a horizontal 
length of 10m, height 2m and is loaded by a vertical line load of 30 kN/m . 
 

 
 
The Shear Force deformation  is neglected to have a good comparison with analytical results. Using 
an Average Mesh size for curved elements  of 0,1m, a Stability Calculation  yields a critical load 
factor of 0,46. 
 

 
 

 
 
 
 
The first buckling mode has the following shape: 
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This result can be checked using an analytical formula from Ref.[28]. The critical lineload for a fixed-
fixed arch with height 20% of the support distance is given as: 
 

 K�� = 103,2 qve³ 
 

 
With: E = Modulus of Young = 210000 N/mm² 
  I = Moment of inertia = 666666,67 mm4 

L = Distance between supports = 10000 mm 

� Pcr = 14,448 kN/m 

 
The loading P on the structure was 30 kN/m so the critical load coefficient can be calculated as: 
 

 u = <��x = 'm,mmf	yz/��{	yz/� = |, }~ 

 
 

This result corresponds to the result of Scia Engineer. 
 
 
Using the critical load coefficient, the buckling load of the arch can be calculated. The minimal normal 
force N under the given loading is 195,82 kN. The minimal is used since this will give a conservative 
result for the buckling length. 
 

 
 
The buckling load Ncr can then be calculated as: 

 
 J�� = u ∙ J = 0,46 ∙ 195,82 = �|, |���	�� 

 
Applying Euler’s formula, the buckling factor k can be calculated: 
 

  J�� = :²∙q∙v(y∙g)l    
�  c = 'g ∙ Y:²∙q∙vz��  

 
In which s specifies the arch length of 10,982m 
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The parameters can now be inputted: 
 

c = 1/ ∙ �;² ∙ 8 ∙ 9J�� = 110982�� ∙ �;² ∙ 210000J/��² ∙ 666666,67��m
90077,2J = |, �� 

 
This buckling factor can now be inputted in the buckling data of the arch so it can be used for a Steel 
Code Check. 
 
This example illustrates the use of a stability calculation for a simple arch. The same procedure can 
now be applied to more complex structures like arched bridges, truss beams, concrete buildings,… 
 

 
  
 

Example: Buckling_Arch_FEM.esa  
 
To illustrate the use of stability in finite element calculations, the arched bridge of the previous example 
is modelled as a shell element. 
 

 
 
Using an Average Mesh size of 2D element  of 0,1m, a Stability Calculation  yields the following 
critical load factor: 
 

 
 
The corresponding buckling mode can be shown by viewing the Deformed Mesh  under 2D Members  
> Deformations of Nodes 
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The result corresponds to the analytical solution shown in the previous example. 
 

 
 
 

Example: Buckling_Arbitrary_Profile.esa  
 
In this example, the buckling load for a composed column is calculated. The column has a variable 
section consisting of two different cross-sections. 
The critical buckling load is compared with the analytical result from Ref.[6]. 

 
 
The loading is taken as 1 kN so the critical load coefficient equals the critical buckling load. To obtain a 
correct comparison with the analytical calculation, the shear force deformation  is neglected: 
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The formula for the buckling load of a member with arbitrary cross-section is given in Ref.[6], pp.114 by 
formula (2-48): 
 

K�� = � ∙ 8 ∙ 9�`²  

With m a parameter depending on the length of the different sections and the ratio I1/I2. This 
parameter is specified in table 2-10 of Ref.[6]. 

 
I1 8.356 107 mm4 
I2 4.190 108 mm4 
a 4 m 
l 10 m 
a/l 0.4 
I1/I2 0.2 
m 4.22 
Pcr 3713 kN 
 
 

A Stability Calculation  gives the following result: 
 

 
 
This result corresponds to the analytical solution. 
The corresponding buckling mode has the following shape: 
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Note: 

The buckling shapes can be animated through View > New Animation Window 
 

 
 

 

Example: Stability_EC3.esa  
 

As seen during the 2nd Order calculations, according to EC3 Ref.[27], a 1st Order analysis may be used 
for a structure, if the increase of the relevant internal forces or moments or any other change of 
structural behaviour caused by deformations can be neglected. This condition may be assumed to be 
fulfilled, if the following criterion is satisfied: 

 

10≥=
Ed

cr
cr F

Fα  for elastic analysis. 

With:  αcr The factor by which the design loading has to be increased  
               to cause elastic instability in a global mode. 

    FEd The design loading on the structure. 
Fcr The elastic critical buckling load for global instability,      

                based on initial elastic stiffnesses 
 

The factor αcr thus corresponds to the critical load coefficient calculated through a Stability calculation. 
The frame was regarded in a previous example and had the following geometry: 
 
 

 
 
A Stability Calculation  gives the following critical load coefficients for the design loading: 
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The lowest positive factor of 13,17 has the following buckling shape: 
 

 
 
 
Since this lowest factor is higher than 10, this implies that a 1st Order calculation  may be executed; 
the structure is thus not sensitive for 2nd Order effects. 
 

 
 

Example: Stability_Imperfection.esa 
 
In Chapter 6, the use of the buckling shape as imperfection according to EC3 was discussed. In this 
example, the procedure is illustrated for a column. 
 
The column has a cross-section of type IPE 300, is fabricated from S235 and has the following relevant 
properties: 
 

 

 

 

E = 210.000 N/mm² fy = 235 N/mm²  γM1 = 1.00 

L = 5000 mm  A = 5380 mm² 

Iy = 83560000mm4  Wpl,y = 628400 mm3 

 

Calculation of the buckling shape 
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First a Stability calculation  is done using a load of 1kN. This way, the elastic critical buckling load Ncr 
is obtained. In order to obtain precise results, the Number of 1D elements  is set to 10. In addition, the 
Shear Force Deformation  is neglected so the result can be checked by a manual calculation. 
The stability calculation gives the following result: 
 

 
 
This can be verified with Euler’s formula using the member length as the buckling length: 
 

J�� = ;² ∙ 8 ∙ 9`² = ;² ∙ 210.000 J��� ∙ 83560000��m
(5000	��)� = 6927,51	cJ 

 
 

The following picture shows the mesh nodes of the column and the corresponding buckling shape: 
 
 

   
 
Using for example an Excel worksheet, the buckling shape can be approximated by a 4th grade 
polynomial. 
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A polynomial has the advantage that the second derivative can easily be calculated. 
 

� ��� = 2,114	 ∙ 10&'� ∙ �m − 2,114 ∙ 10&f ∙ �� + 7,132 ∙ 10&[ ∙ �� + 2,285 ∙ 10&' ∙ � 

� ���� = 8,456	 ∙ 10&'� ∙ �� − 6,342 ∙ 10&f ∙ �� + 1,426 ∙ 10&a ∙ � + 2,285 ∙ 10&' 
� ���" = 2,537	 ∙ 10&'' ∙ �� − 1,268 ∙ 10&� ∙ � + 1,426 ∙ 10&a 

 
 
Calculation of e0 

 
 

J�y = G" ∙ b = 235 J��� ∙ 5380��² = 1264300	J 

 6�y = G" ∙ N<= = 235 z��l ∙ 628400��³ = 147674000	J�� (Class 2) 
 

u̅ = �J�y/J�� = �1264300	J6885280	J = 0,43 

 
=α 0,21 for buckling curve a 

 
 

� = 1
0,5 �1 + ��u̅ − 0.2$ + �u̅$�� + Y�0.5 �1 + ��u̅ − 0.2$ + �u̅$���� − �u̅$� = 0.945 

  
 
 

These intermediate results can be verified through Scia Engineer when performing a Steel Code Check 
on the column: 
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,{ = ��u̅ − 0.2$ ∙ 6�yJ�y ∙
1 − � ∙ �u̅$���'1 + � ∙ �u̅$� 

 
Or with ��' = 1.00: 
 

,{ = ��u̅ − 0.2$ ∙ 6�yJ�y = 0.21(0.43 − 0.2) ∙ 147674000	J��1264300	J = �. �|�	�� 

 
 
The required parameters have now been calculated so in the final step the amplitude of the 
imperfection can be determined. 
 
 
 
Calculation of ηinit 
The mid section of the column is decisive ⇒ x = 2500 mm 
 

 crη at mid section = 368,4 

 
 

 ���" = 2,537	 ∙ 10&'' ∙ 2500� − 1,268 ∙ 10&� ∙ 2500 + 1,426 ∙ 10&a = −1,443	 ∙ 10&m ∙ 1/��² 
 
 

�!L!� = ,{ J��8 ∙ 9" ∙ ���,�T " ∙ ��� = 5,605	�� 6885280	J210000J/��² ∙ 83560000	��m ∙ 1,443	 ∙ 10&m ∙ 1/��² ∙ 368,4 

 
= 5,615 mm 

 
 
This value can now be inputted as amplitude of the buckling shape for imperfection. 
 
 
To illustrate this, the column is loaded by a compression load equal to its buckling resistance.  
 
However, due to the imperfection, an additional moment will occur which will influence the section 
check. The buckling resistance can be calculated as follows: 
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J�,�> =	� ∙ b ∙ G"��' = 0,945 ∙ 5380	��² ∙ 235 J���1.00 = ���}, ��	�� 

 
 
A non-linear combination is created in which the buckling shape as imperfection is specified. 
 

 
 
 
Using this combination, a non-linear 2nd Order  calculation is executed using Timoshenko’s method . 
 
 
The additional moment can be easily calculated as follows: 
 

6����� = Jq> ∙ �!L!� ∙ 1
1 − Jq>J��

= 1194.76	cJ	 ∙ 5.615	��	 ∙ 1
1 − 1194.76	cJ6885.28	cJ

= ~. ��	��� 

 
 
When performing a Steel Code Check on the column for the non-linear combination, this can be 
verified. The critical check is performed at 2,5m and has the following effects:  
 

 
 
The additional moment thus corresponds to the moment calculated by Scia Engineer. 
 
As seen in the diagram, Path 3  is followed: the buckling shape serves as a unique global and local 
imperfection. This implies that only a section check and Lateral Torsional Buckling need to be checked. 
Since LTB is negligible with this small bending moment, only a section check is required. 
 
This example has illustrated the use of a buckling shape as imperfection. Depending on the geometry 
of the structure, this imperfection can have a large influence on the results due to the additional 
moments which occur. 
 
When using this method, it is very important to double check all applied steps: small changes to the 
loading or geometry require a re-calculation of the buckling shape and amplitude before a non-linear 
analysis may be carried out.  
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As a final note: the buckling shape only gives information about a specific zone of the structure. The 
imperfection is applied at that zone and results/checks are only significant for that zone. Other 
combinations of loads will lead to another buckling shape thus to each load combination a specific 
buckling shape must be assigned and a steel code check should only be used on those members on 
which the imperfection applies. Since the applied buckling shape corresponds to a global mode, failure 
of these members will lead to a collapse of the structure. 
 

 

6.3 Non-Linear Stability 

As specified in the assumptions of the previous paragraph: a Stability calculation is by default a linear 
process. Non linearities like friction supports, pressure only supports… are not taken into account. 
 
Beam non linearities are also taken into account in the linear stability calculation. 
 
Specifically for this purpose, Scia Engineer provides the use of a Non-Linear Stability Calculation. This 
type of calculation has the following additions to the Linear Stability calculation: 

- Local Non-Linearities are taken into account 

- 2nd Order effects are taken into account using the Modified Newton-Raphson  algorithm. 
 
 
Modified Newton-Raphson follows the same principles as the default method but will automatically 
refine the number of increments when a critical point is reached and will only update its stiffness matrix 
every N iterations. This method can therefore give precise results for post-critical states. 
 
Scia Engineer will perform a 2nd Order calculation taking into account Local Non-Linearities. After this 
calculation, the resulting deformed structure is used for a Stability calculation. As a result, the Critical 
Load Factor of the structure is obtained for the structure including Non-Linearities. 
 
To activate the Non-Linear Stability calculation, the functionalities Stability  and Nonlinearity > 2 nd 
Order – Geometrical nonlinearity  must be activated. 
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In addition, Support and/or Beam local nonlinearities can also be activated. 
 
 
 
The choice of the 2nd Order Theory, the amount of increments and the maximal amount of iterations 
can be specified through Calculation, Mesh > Solver Setup. 

 
 
Since the non-linear stability calculation automatically implies the Modified Newton-Raphson method 
for the solver, this method cannot be chosen here. The reason why this field is available is to perform a 
normal 2nd Order Calculation using Modified Newton-Raphson instead of a Stability Calculation. 
 
Since the Modified Newton-Raphson method also applies the loading using increments, it is important 
to set a right amount of increments. This implies that it is advised to choose the Newton-Raphson 
method so the user has access to the number of increments. 
 
 

Example:  Stability_Falsework.esa 
 
 
In this example, a Stability analysis is carried out on a large falsework structure measuring 15m x 15m 
x 12m. 
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All diagonals of the structure have been given a gap of 1mm . 
 

 
 
 
The structure is loaded by its self-weight, formwork and concrete for a total loading of +/- 18.000 
tonnes. 
 
First a Linear Stability  calculation is carried out to evaluate the critical load factor. The number of 1D 
elements is set to 5 to obtain good results without severely augmenting the calculation time. 

 
 

The following result is obtained: 
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The critical load factor is smaller then 10 which indicates that the structure is susceptible to 2nd Order 
effects. Therefore a 2nd Order calculation is carried out using Newton-Raphson . The number of 
increments is set to 5 and the maximal number of iterations is set to 50. 
 
 
The 2nd Order calculation leads to the following message: 
 

 
 
 
This implies that the 2nd Order calculation does not converge to a result but leads to instability. The 
question now rises as to what causes this instability. 
 
 
This is the point where the Non-Linear Stability calculation comes in. During the Linear Stability 
Calculation, the Gap elements on the diagonals of the structure were not taken into account. A Non-
Linear Stability calculation takes into account both 2nd Order effects and the Gap elements. 
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The Non-Linear Stability  Calculation gives the following result: 
 

 
 
This result gives a very important conclusion: the structure including all Gap elements is not capable of 
supporting the loading. Only 26% of the loading can be supported before instability occurs. This is the 
reason why the 2nd Order calculation does not pass. 
 
When Local Non-Linearities are used, it is mandatory to execute a Non-Linear Stability calculation to 
draw correct conclusions concerning the global buckling of the structure. 
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7. Troubleshooting 

In this final Chapter, some common failure messages are given which can occur during a non-linear 
analysis. 
 

7.1 Singularity 

Singularity problems occur frequently during a non-linear calculation. Messages of the following type 
are generated by Scia Engineer: 
 

       
 
 
The cause of these messages can be the following: 

- The structure is a mechanism: check supports, hinges, unconnected members,… 

- The structure becomes a mechanism by eliminating elements (members, supports,…) Examples 
include tension only diagonals which are all eliminated, a subsoil (only compression) which 
comes entirely under tension,… 

- The structure becomes unstable due to the creation of plastic hinges. 

- The entire structure or part of it buckles. In the stiffness matrix this implies that KG > KE 

- The instability is caused due to small section properties of manually inputted cross-sections. In 
many cases, the torsional resistance It is too small. 

- As explained in the theory, the Timoshenko method is not suitable when the normal force in a 
member is larger then its critical buckling load. In this case, Newton-Raphson should be applied. 
To find out which cross-section causes this problem, the sections can be modified alternately 
until the 2nd Order calculation passes. 

-  

7.2 Convergence 

 
If, during a non-linear analysis the criterion of convergence is not met, messages of the following type 
are generated by Scia Engineer: 
 

    
 
 
The cause of these messages can be the following: 

- Too few iterations have been specified in the Solver Setup. 

- The structure is close to instability. 
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- Cyclic elimination of members or supports: the elements are eliminated during an iteration and 
are re-instated during the following iteration. 

-  
To examine this in detail, the calculation can be executed for for example three iterations: take 
iteration i-1, i and i+1 and compare the results.  
 
In these results, there will be a difference in one member (for example in one iteration the 
member is in tension, in the following iteration it is in compression).  

- If the non-linear stability calculation does not converge, make sure 2nd Order is activated as 
functionality. 
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